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Typographical conventions:

© The “»” symbol indicates an action which must be performed by the user.

© <PolySpaceInstallDir> stands for the directory/folder name where the PolySpace products were installed.
© The “Courier New” font is used for mentioning data seen on the screen of the computer.
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General Requirements

l.1. Computer Configuration

Please refer to PolySpace installation manual for the minimum hardware requirements.

The timing is the following:

* The installation of PolySpace products takes around 5 minutes
(see the complete installation guide as available from the PolySpace installation CD-ROM
in \Docs\Install\PolySpace_Install_Guide.pdf).

* The first step of this tutorial takes about |15 minutes.

* The second step of this tutorial takes about |5 minutes.

* The third step of this tutorial takes about 5 minutes.

* The fourth step of this tutorial takes about 5 minutes.
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1.2. Structure of this document

Once the installation is done, you can launch PolySpace by using the following icons that were placed
on your desktop:

PolySpace Launcher W-—H | PolySpace Spoaler PolySpace Viewer
Shortout ,_-l_ Shorteut Shortout
ZKB FJ ZKB F.] ZKB

Also, inside PolySpace Client and PolySpace Server, a PolySpace MISRA Checker is available,
allowing the verification at compilation time of the rules recommended by the MISRA Consortium
(more about MISRA Consortium at http://www.misra-c.com).

This Getting Started will focus on the following four exercises using PolySpace Client, PolySpace Viewer,
PolySpace MISRA Checker and PolySpace Remote Launcher:
* In Step | we will analyze a simple file “example.c” by using PolySpace Client
* In Step 2.we will review the results obtained during Step | by using PolySpace Viewer
* In Step 3 we will use PolySpace MISRA Checker during the compilation phase of a PolySpace analysis.
* In Step 4, we will send an analysis remotely to a server.




Step 1.

PolySpace Client - Setting up
and launching an analysis of a single C file

This paragraph describes a basic file analysis. It focuses on the analysis of “example.c”, which is included
in the PolySpace installation directory and located at:
<PolySpaceInstallDir>\Examples\Demo C\sources\example.c.

The PolySpace analysis process is composed of three main phases:

I. First, PolySpace checks the syntax and semantic of the analyzed file(s). However, as PolySpace is not
associated to a particular compiler, benefits of this phase are triple for the analysed source code:
ANSI compliance, portability and maintainability.

2. Then, PolySpace seeks the main procedure. If none is found, PolySpace Client will generate one
automatically. By default, this function will call all public functions of the file.

3. Finally, PolySpace proceeds with the code analysis phase, during which run time errors are detected
and highlighted in the code.

2.1. Analysis prerequisites

Any analysis requires the following:

* PolySpace products and its related license file and dongle correctly installed;

* Source code files (in this case “example.c”) and all header files that it may directly or indirectly
include. For this tutorial we will see later that we need two header files “math.h” and “include.h”
in order to analyse “example.c”.

* All “-D” compilation switches necessary to compile the file are known.

Please note that in this tutorial, no “-D” is necessary to compile “example.c”.
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2.2. Setting up a PolySpace Client analysis nolispace|Client./server Launcher
Sel d Select a .

» Double-click on the PolySpace launcher icon: et 2 prode et 2 enaiage
&+ Client Launcher = C

g PalySpace Launcher
Shortout -5 L . -
a ZKB erver Launcher -+

" AdaB3/hdads

A window appears proposing to choose the product to be used

for the analysis and the language of the file to be analyzed: o | Caiee!

If PolySpace is not installed for some languages, these choices of languages will be grayed out.

» Select “Client Launcher”, language “C” and then, click on OK .

e I
The Graphical Interface
of PolySpace analysis Launcher
is displayed as follows:
e
» °
I
B covioLes sonenmworn: 6] ]
B
& rurton
e 8




Step 1. PolySpace Client - Setting up and launching an analysis of a single C file

-] PolySpace Client

» Click on File/New Project to start an analysis: L 10 op

) Open project T

l |,
“; |Chck here to create a new project | - - » _
hZ oy,

= Path

¥ Quit Chrl+Q

Ll
The PolySpace Client

[ PolySpace Client for C - New_Project

New Project window o cin ok e

opens. It contains four LECALTR R R B B
sections: s s E:) ‘::g;‘mm o e e
* At the very top, the - T

title bar, which contains s — i

usual icons and menus; e e —

Keep-al-fies.
Lcortinue-witred-error

Keep al ntermeciate fles.

* Top left is the list of

Cortinue with the

files to analyze, along e o nuorsin:

with include and results B
directories: e ;

* Top right is the set of
options associated with ResutsDiecory [-cesuies-ate ]
the analysis that will be -7 E
processed; R e e

* The bottom area allows
following the execution @;Z;“j”g it K )]

and progress of the ~lagien

analysis.

Lcortinue-wih-existing-host

OoooE

et parameter
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» In the “Look in” section, click on * and select

“<PolySpaceInstallDir>\Examples\Demo C\sources”. A list of files appears in the box.
The default <PolySpaceInstallDir> is C:\PolySpace\PolySpaceForCandCPP.

Results Directory [-results-dir]
» Start by updating the result directory name

CPolySpace_Results
by clicking on the browse button :

This directory is the one where PolySpace Client will store the results of the analysis. In this Getting Started,
we will choose the default directory: “C: \PolySpace Results”.

il Please select a file
» Now, click on the button M —
(right of the “New Project” label). —
It opens the “Please select a file”
window, from which you can select Q i/
one or several files to analyse. =] tasket.

[£] taskst &
[E] tasks2.¢

B EBDO

w| 1 My Computer
2 B v Foney e
(= Local Disk (C)
1 PalySpace
32
) Exarples
1 Demo_C
i sources

(% c) files only
[]Recurse subdirectories

Soures flles [-sources] Directories to nclud [4]

» Select “example.c” and click on in the “Source files [-sources]” section (bottom right)

of the window. The file is now listed among the source files to be analyzed.

10
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n Please select a file

|_| soUrces

Lok in:

2 EBE06

ple.c

E] inttislizations .c
E] main.c

@ single_file_analysiz.c
E] tasksl o

E] tasks2.c

A PR
3 <

(*.c] files only

|:| Recurse subdirectories
Directories to include [-1]

Source files [-sources]

» Click on OK to go back to the “PolySpace Client for C - New Project” window.

Note: it is also possible to drag a directory or source files and drop it in the “File Name/Absolute Path” part
(top left of PolySpace Client) without using the “Please select a file” window.

1
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2.3. PolySpace Client: running the analysis

» Click on to start the analysis. Alternatively, you can click on the button in the title bar to run
PolySpace Client with the current setting.

The window titled “Save the project as” opens. You can decide where to store the configuration
information related to the analysis. Here, create a file called “demo” and save it in the PolySpace result
directory. The full name of that file will be “demo.dsk”.

Save the project as ...

Look in: |5) PalySpace_Results ' ? %) E‘ E

ie)
My Recert
Dacumerits

Deskiop

My Documents
=1
59
My Computer
;; Session idertifier | demof
My Metwork B
Places Files of type: = sk v

» Click on to go back to the “PolySpace Client for C - New Project” window

and click again on to proceed forward.
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Il PotySpace Desktop for C - C:\PolySpace_Results\demo. dsk
Fie Edt Tods el

Dom b xo A »rHEH> O

P = Search ntermal nae from the selected ine :| |0

Name. Value nternelname.
SiGeneal _

File Name:

New Project prog

Dete. 040412005 dete

Author oot author

Project version 10 verit-version
scalar assigrmerts o

fles Keep-al-fies
Lcortinue-wih-rec-ertor

Lcortinue-wit-sxistig-host

Cortinue even if
Cortinue with the current configurstian

roetiCompler

mplance with standards

JySpace imner sefings

ncluce directories (]

Results Directory [-results-dir]

Clyspacs Rests IE)

°

e Lt BT i T e e
w0000 w000 wobm  woony  meew | wme | Gowm oot

B compie oo searchintneog: [({ [ |[0)]

s feritying st contiguration .-

Frary ooy > sooto | w o
w o
vy 5 o ¥o < exror ¢
Seriel pore comt avetleble K

* 1 error occured
Errors found when verifying host configuration.

ou must £ix then before launching again
or use -continue-with-existing-host v

A progress report is displayed in the bottom part of the graphical interface, indicating that the analysis is being
performed. The » button is also grayed out.

Note: you may use the Stop Execution button - - to interrupt the analysis but it is not part

of the current tutorial.
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2.3.1. Parsing errors during preliminary PolySpace analysis stages

After some checks, Pol ill sh n error m : '
fter some checks, PolySpace will show an error message ey @
@ ‘erification process Failed

Let’s try and understand why we get this error message.

First possible cause for the error message:
Hardware recommendation
If this happens, please verify whether your computer meets the minimal hardware requirements described in section

“General Requirements”. A message similar to the one below would be displayed in the bottom part
of the graphical interface:

» To help you understand the issue, you can search into the log file. Type “host” in the “Search in the log:”
box and click on @ to check whether the error corresponds to a hardware recommendation problem.

If you have a problem related to host configuration, in order to continue analysis, you can either:
* upgrade your computer to meet the minimal requirements
* or use the —continue-with-existing-host option which overrides the initial check for minimal hardware configuration.

» To set up the —continue-with-existing-host option, please type “continue”
in the “Search internal name from the selected line” box

at the tOP I'ight Of the window Search internal name from the selected line | cortinue |

14
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» Then click on . It will show all options containing the word “continue” as shown below:

!IZ-

Search internal reame from the selected fine : | cantinue 2
Name Value ntemal name
\anatysis options
=1 General
Session dentifier New Proiect prog
Date 18/05/2006 clate
Author bard author
Project version 10 Lverit-version
Exarine effects of scatar ] voa
Keep al intermediate fles Leep-al-fies
Loontinus-with-red-srror
Cantinue wih the currer O Leontinue-wih-existing-host
Continue even on an Linu distriution I e

& TargetiCompier
Cotrpliance with standards

PuolySpace inner settings
& "
Multtasking

» Check the box | | in the “Value” column that is associated
to the “-~continue-with-existing-host” line as shown below.

» It is also recommended to select the —continue-with-red-error option. Indeed, “example.c”
contains — on purpose - code with some definite errors, later called red errors. This option allows you
to continue the analysis even if red errors are detected. Otherwise, the analysis would just stop after
the detection of the first of these errors.

Cortinue even if red errors are detected | | Lcominue-wﬂh-red-error |
. | Lcominue-wﬂh-exisﬁng-host |

15
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Second possible cause for the error message: Information about Header files
Another cause of error may be that PolySpace Client misses some information about header files.

°

e B T T T )

In the tutorial, as shown

ELT™ 05-target solaris (defeult] implies: -D_STDC_ -D_GNUC_ =2 -D_GNUC_NINOR_ =8 -D_GNUC_ =2 -D_GNUC_NINOR_ =8 -D_GCC_NEW_VARARGS_ -Dunix -D_unix -

cessing err
-~ Please correc © them and launch the analysis again.

polyspace-c : problen during ree-suif tool

o000 o000 o000 o000 o000 w0000 000n1a

| on the screen capture opposite,
the file named “math.h” can not
be found. To fix this problem,
you need to indicate its location.
As PolySpace is not associated
with one particular compiler,

< itis mandatory to indicate

>

where library files are stored.

In our “example.c” file analysis, the related “math.h” file is located in the same directory as the C file:

<PolySpaceInstalls>\Examples\Demo C.

» Open the “Please select a file” window
by using the button (right of the “demo.dsk”
label in the top right of the interface)

» Select “<PolySpaceInstallDir>\Examples\
Demo_C\sources”, where “math.h” is located.

» Click on in the “Directories to
include [-I]” section and then close the
window using

Notes:

|. The other header file needed “include.h”
is located in same directory.

2. It is also possible to drag a directory and drop it
in the “include directories [-I]” part

- Please select a file E

Lookin:  |] Demo_c

() AL ~
) PolySpace-Doc
o

(*.c) files only

[[] Recurse subdirectories

Source files [-sources]

Directories to include [4]

(top left of PolySpace Client) without using the “Please select a file” window.

16
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2.3.2. Progression of the analysis

» Click on to restart the analysis.

Some results may have already been written in the “C: \PolySpace Results” directory, because of a previous
click on [ »Eexecute |. Therefore a window opens to check whether you want to overwrite them:

PR

In our example, this is what we want to do. Click on |_Yes

@ The directory C:iPolySpace_Results already exists,
Some files might be overwritten, Do you want ko continue 7

Yes Cancel

Note: closing the PolySpace Client window will not stop the PolySpace analysis. If you wish to stop it,

click on (you will be asked for confirmation). If the window is closed without stopping the
analysis, the analysis continues in the background. Opening again PolySpace Client with the same project
automatically updates the analysis with its current status.

The progress bar allows following the progress of the analysis:
aile 10 i ] COF& - 0% ] Levell : 0% ] Level2 : 0% ] Leveld: 0% ] Leveld : 0% ] Total
00:00:39 00:00:07 00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 00:00::54

A progress report may be obtained by clicking on Ef cowetsn  for the compilation phase, or &stae for
the full analysis in the bottom part of the window. Click on | [& ruLey to get additional information about

the current analysis (list of options, stubbed functions, functions used during main construction, checks found
after each phase, etc.). Click on the icon to refresh the summary.

17
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2.3.3. End of the analysis

When the analysis ends, PolySpace proposes to review the results:

@ Werification process completed,
Do you want to launch PolySpace Viewer 7

» Click on , and go to the next section of the tutorial to view the results.
If you click on [ cancel |, and if no other analyses is running, you can access the results via the 4 icon in the title bar.



Gfep 2. PolySpace Viewer - Exploration of results

This step illustrates how to explore analysis results that were generated by either PolySpace Client
or PolySpace Server. We review the results of the analysis of “example.c” performed during Step |.

You can access the results of any successful analysis E s p?ce NERER
by double clicking on the PolySpace Viewer icon: 7 2Ko

If the button has been clicked at the end of the previous analysis (see previous section),

PolySpace Viewer automatically opens results.

3.1. PolySpace Viewer modes of operation

The first time the PolySpace Viewer is opened, a window
will appear to describe the different modes of operation.

¢ In “Expert mode”, all checks can be seen.
The number and categories of checks to be reviewed as well
as the order in which to review them can be chosen
by the user (See next section).
* In “Assistant mode”, the rules of the review follows
a methodology selected by PolySpace. The “best” subset
of checks will be automatically selected and sorted out.
The PolySpace Viewer will then guide the user through
these selected checks.

» For this tutorial, please untick
“Do not display this message again”
and then click on “Expert mode”.

& New feature EJIEISJ

Flease select...

The Viewer has two modes of operation.
Choose between:

- The new review assistant wizard,

- Or the expert Viewer mode.

The resiew assistant helps you to select and tnanage the checks to
he reviewed.

You will be able to select the number of checks to be reviewed and
the "best" subset will be sorted out for you by PolySpace. The
Wiewer will then guide you through these selected checks.

Do nat display this message again

[ Expert mode H Azsistant mode

Note: The mode of operation may be changed later in PolySpace Viewer.

19
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3.2. Download results

After having clicked on “Expert mode”
the PolySpace Viewer window looks
like the one on the left:

| [conen ! Please select a file @

(Ee——

Look in ‘h PolySpace_Resuts V‘ T 2EE
5 AL
uﬁ |0 PolySpace-Dac
Polyspace My Recent [ RTE_p0_02_Control_Dete_Flow_snalysis rte
TECHNOLOGIES Documents R RTE p1_02_Safety_Anslysis_Level 1 rte
o i = [ RTE_p2_02_safety_analysis_Level 2rte
” SRt REE G coes = L [ RTE_pa_o2_Satety_analysis_Level_3te

Desktop 3RTEJ:4 02_Safety_Analysis_Level_d4.rte

G

My Documerts

» Click “File>Open” to load your result files.
If you did not perform the analysis, you can still review
the results by opening the following file:
<PolySpaceInstallDir>\Examples
\Demo C\RTE px 02 Demo C LAST RESULTS.rte

My Computer

My Metwark
Places

» Then click on to proceed with further steps

Note: The RTE px 02 Demo C LAST RESULTS.rte

is a “link” to the best results for the analysis in term of precision:
RTE p4 02 _Safety Analysis Level4.rte.

Other results have lower precision.

Flename: | E_px_02_New_Project_LAST_RESULTS e |

Files of type: [+ yge v [ cancel |

20
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3.3. Reviewing PolySpace results in “Expert” mode

After loading the results in “Expert” mode, PolySpace Viewer window looks like below:
I. On the left is the run-time error view

BB PolySpace Viewer - C:\PolySpace_Results\RTE_px_02_New_ Project_LAST_RESULTS. rte [®]=]E]

Pt teo ‘ — (RTE or “Procedural Entities”

O @l o ol 4 8@ 1 G wem s || G Pl . . A y

e I = o IS o oo e View). It displays the list of files
Procedural ertes 1x P e varion o| Bc: a i “
E QQ‘JH = = analyzed |n"theI Procedural

: ‘ o o]n| (R 125 - Rt entities” column.

e | frteneytask Al [ eampleseta -
e = PR 2. In the bottom right area is the

source code view. Each operation

checked is displayed using meaningful

colour scheme and related diagnostic:

* Red: Errors which occur at every
execution.

. Warning — an error may
POIYSpace occur sometimes.

TECHNOLOGIES

b » Grey: Shows unreachable code.
in partnership with CAS « Green: Error condition that will
never occur.

3. The two windows just below

the tool bar display details about

. ; the currently reviewed check

— (when the check has been selected):

'PulySpﬂl:e Viewer - C:\PolySpace_Results\RTE_px_02_Mew_Project_LAST_RESULTS.rte

4. The top right area is used for displaying
both control and data flow results.

You can switch from one view to the other
by using the “Windows” menu:

a2 e e
Yertically
Switch to Wariables view

21
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3.3.1. Procedural Entities view
Each file and underlying functions in the RTE view is colorized according to the most critical error found:
e polyspace main.c. This file contains the main which was automatically generated by PolySpace.

All checks there are green: no run-time error (or RTE) has been found.

L
Step 2: PolySpace Viewer - Exploration of results |l@
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 example.c. This file is red: one or more definite run-time errors have been found in it.
» __ polyspace_stdstubs.c contains no checks and is thus not colored.

It contains stubs of standard functions part of 1ibc library used in example.c.

Bl PolySpace Viewer - C:\PolySpace_Results\RTE_px_02 New_Project LAST_RESULTS. rte
Fie Edt Mindows Help

=2 BRI I |

S wem || G P

<

[ New_Project

£ s 3 na | [[soat | [ g || o]
g oml x v o wn o [ ] e e o o [ e ] e e e
Procectral enes % | 1] %] ] oetais
|5 New_Project 91 (4|13 26 Variables
% __polyspace_main.c 0 |_palyspace_r o [ new Project
iten by
e Ak (151 | 3 |26texample:c: . , | _polyspace_ststubs ermo
B Close_To_Zera () 100 3 lexample ¢ i
it by task 4l
@ Non_infinite_Loop () 100 4 |example.c
read bytask 13
= Pointer_Arithmetic () |88 | 1|1 | 1|5 examplec
potentaly written by
= RTE () 100/ 1 3 example.c
Potentaly Read by
80 4 |example.c
® Recursion_caller () | 100( 1 2 example.c
= Souare_Root () 100/ 1 1 lexample.c T
@ Souare_Root_conv () 100 2 example.c
1 #include <math.h>
® Unreachable_Code () 100 2 pample.c 3 A teie Pincuders
0 example.c 3
® __polyspace_stdstubs.c | O |_patyspace__| § ¢
5
6
7 /* Internal function */
8 /* Needed for MISRA-rule B.1 */
9 static int get_oil pressure (void);
10 static void Close_To_Zero (void);
11 static int Non_Infinite_Loop (void);
<

» example

fory
O calledby 4
OQeais »
[ compiete

Update on salection

Ve

>

Source file: example.c  example Unreachable_Code  Line: 199 Colurn:12

» Select the “Beta” filter

in the combo menu in

the toolbar and click once
on + sign at the left of
“example.c” to find out
more about this file.
“example.c” is expanded
and the list of functions
defined into it is displayed.
The functions in red or grey
(Pointer Arithmetic(),
Square Root (), etc.) have
code sections that need to be
inspected first because

they are definite diagnosis

of PolySpace (either runtime
errors or dead code).

22
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The columns (ﬂ, ﬂ, ﬂ, x|, J,...) provide information about run-time errors found in each function:

* The ﬂ column indicates the Software reliability indicator in percentage (level of proof).
100% means a complete reliability of the code for the category checked by PolySpace
with the hypothesis taken for the analysis.

* The ﬂ column indicates the number of definite run-time errors or reds,

e The J column indicates the number of unproven or
(may be run-time errors that do not occur systematically),

* The ﬂ column indicates the number of safe operations or
* The *| column indicates the number of unreachable instructions or grey code sections.
* The Feviewed column allows marking reviewed checks.

Procedural entities

Let’s have a look at some errors found by PolySpace in “example.c”. 125 New_Project

4 polyspace_main.c

First example of runtime error found by PolySpace: & example.c
Memory Corruption ® Close_To_Zern ( )
» Click on H to exp.and “Poi.nter_Arithmetic () “ to find out more aF)out = Non_infinite_Loop ( )
the red error. It displays a list of red, , and symbols, featuring - ] )
the complete list of code areas that PolySpace checked within Fointer_arimetic ()
the “Pointer Arithmetic ()” function. ¥ IDP 4
o IRVT
< IRV.E
‘ Ieed]
X UNR.14
IRV.1G
« IDP 26

23



L
Step 2: PolySpace Viewer - Exploration of results |!@
|

» Click on the red “IDP.9” item - which stands for lllegal De-referenced Pointer -, to precisely locate this error
in the source code. The bottom right section is updated showing the location of the “IDP.9” item.

» Click on the red symbol in the source code at line 104. B cxampte-Pointer_ritheti... (=] 5[]
An error message is opened: in "example.c” line 104 column 10
Source code
Pointer p is de-referenced outside of its bounds.
Indeed, at the line 71 the instruction “*p = 5;” ff=ze=l Bpoisteriicgostsiueniteibounds)
corrupts the memory as it puts the value “5”
outside of the array “tab” pointed to by the pointer “p”.

Information about this red |DP is Coding review progress ) Court Progress example.c [ Poirter_Arithmetic /line 104 / calurmn 10
by IDP reviewved / nib IDP to review (Red) lort | of
also accessible in the right b reviessed 7 nb to review (Red) o | o ® #p = 5; /* out of bounds */
. A Sattwate reliabitty indicator |san1s | ao|
windows below the toolbar line. oE
The left one gives some statistics Error : pointer iz outside its bounds
about all the IDP in the analysis: =

IR Error call graph for example.Painter_irithmetic.IDP.9 - PalySpace Viewer

» You can also see the calling sequence leading to
that particular red code section. To do so, select
the “IDP.9” item in the “Procedural entities”
column in the RTE View, and then click on the % icon
(on the top left of the PolySpace Viewer window) to SE—— cxammle. creapices csaaple.c
display the corresponding run-time error access graph:

nain RTE Pointer_Arithmetic P9
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Second example of runtime error found by PolySpace: Unreachable code
» Select “Unreachable Code ()” in the RTE View. You can see that “x = x + 1”

3.

is unreachable (gray colour on each check) 197 otatic void (DN oo
because of the non satisfied boolean condition: |zu00 /* Here we demonstrate BolySpace Verifier's ability to
“x” is never negative when eVaanting “x<0”. 2ol identify unreachable sections of code due to the
20z value constraints placed on the variables.
PolySpace has detected some dead code. 204 .
204 { int ¥ = random int();
205 int v = random int (};
206 g g
207 if (= > ¥}
208 {
209 ®=x -y
210 if (2 < D)
211 {
212 x ==+ 1;
213 }
214 }
215
2la = v
217 }

3.2. Colours in the source code view

Each operation checked is also displayed using meaningful colour scheme and related diagnostic
in the source code view as links:

2.
3.
4.

Red: A link to the error message associated to the error which occurs at every execution.
: A link to an unproven message — an error may occur sometimes.
Grey: A link to a check shown as unreachable code. The error message is in grey.
: A link to a VOA (Value on Assignment) or an error condition that will never occur in the list
of verifications made by PolySpace.

. Black: represents some comments, source code that does not contain any operation to be checked

by PolySpace in terms of run-time errors and optimized operations, e.g. x = 0;.

. Blue: text highlighting the keyword “procedure” and “function”.
. Underlined blue: A link to a global variable in the “Global variable View”.
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3.3.3. More examples of run-time errors
Unlike most other testing techniques, PolySpace provides the benefit of finding the exact location
of run-time errors in the source code. Below are some examples that you can review with PolySpace Viewer.

In a first example of the second set: Arithmetic error

» Click on H to expand “Square Root ()” function. You can see the source code view in the bottom right.
You can also display the call tree for that function by using the “Windows” menu (see previous paragraph).
“Square Root () ” is called by RTE function from “example.c”. It is displayed as "example .RTE”
in the “Call tree view” window (right of the top right section).
“Square Root” calls “random float* (automatically stubbed function), “Square Root conv”
(from example.c) and “sqgrt” (standard library).

179 static wvoid Sguars_Root_conv (double alpha, float *beta_pt)
180 /* Perform arithmetic conversion of alpha to beta */ The green sections into the source

181 { .
182 *beta pt - (fleat) ({1.5 + cos (alpha)}/5.0) s code wetw arfa error-free but the red
183 ) (sgrt) is an issue that needs to be
164 fixed. Indeed, when the local float
185 static void Square Root (void) iabl H d in the li
e o variable gamma is computed in the line
“« «
187 double alpha = randem float (); gamma=5qrt (beta - 0-75> i
188 float beta; the operation will cause a run-time
123 float gamma; error, as the parameter passed to
“« ” .
131 Square_Root_conv (alpha, &heta): Sqrt IS alWa.yS nega’tlve'
152
133 gamma = (float)sgrt (beta - 0.75); /* always sqrt (negative number) */

194 i

Note: using the —voa option when launching the analysis, PolySpace can give more information
about the range on scalar assignments
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AA static int Nen Infinite Leop (void)
a7 { const int big = 1073741821 ; /* 2**30-3 */
(1] int =x=0, y=0;
&5 Second example of the second set:
70 while (1) Non-Infinite loop
71 oo .
. . » Select “Non_Infinite Loop()” in the
73 if (y > big) { break;} “Procedural entities” column in RTE View.
74 o=t 2 The function is fully green: it means that the local
;2 ==l% variable x never overflows, even if the exit
} o . .
- condition of loop deals with y that is smaller _
78 v == / 100; than x. PolySpace confirms that the function E ;
79 return v; always terminates.
a0 }
137 static veid Recursion (int* depth)
138 /% if depth<0, recursion will lead to division by zerc */
139 { float advance;
140
141 *depth = *depth + 1;
l4z advance = 1.0f/ (fleat) (*depth); /* potential division by zerc */
143
144
145 if (*depth < 50)
1lde {
Third example of the second set: |/ | emmemlen sy
Errors due to wrong value passed |1z
to a function call |*** N ; .
« K " 151  static veid Recursion caller(void)
»Select “Recursion caller ()™ |wsz ( int w=randew int0;
The first call to Recursionisinred |2
because when a negative parameter |15 if ((o-9) s o< -1
. g 156 {
2 157 Recursion( &x ); // always encounters a division by zero
is passed, Recursion encounters . .
a division by zero  |w:e )
(See the “Recursion” function). ;5
PolySpace also checks recursive constructs: [is1  x = 10:
lez if (random int () > 0}
163 {
164 Recursion{ &x ); /* never encounters a division by zero */
165 }
leg +
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3.3.4. Advanced results exploration

You can filter the information provided by PolySpace to focus on the type of errors you wish to investigate.

There are pre-defined composite filters “Alpha”, “Beta”, “Gamma”, “User def” and “Filter All”

that you can choose depending on your development process:

» Select “Gamma” to get all
the “red” and “grey” code

B PolySpace Viewer - C:\PolySpace_Results\RTE_px_02_New_Project_LAST_RESULTS.rte
File Edit Took Windows Help

DB o oW B @ L e T rew B sections. It is mainly
x v E o || zo [ o 5| e - e e used during the earliest
. Carl proress ] Nosheckeumenl o0 development stages to focus
Mo check selected [ nia |
b reviewert £ b 1o review (ni) v [ni || = Filter all uickly on critical bugs
20 fturare reliahilt indicator nin fnie 1 User def q Yy gs.

» To illustrate the use of these filters, we will focus on the Pointer Arithmetic function that we have examined
in the 3.3.2 section. Select “-* to hide the checks related to “Pointer Arithmetic()”.

This list of acronyms - for type of operations checked - shows what kind of errors PolySpace automatically looked for.
The “Beta” level highlights checks that could cause a processor halt, memory corruptions or overflows.

Bl Pointer_Arithmetic ()

» Select “Beta” mode (which is the default mode). P

Select again “Pointer Arithmetic ()” in the “Procedural entities” view P

and then, click on the + sign to expand it and get the list of checks: . nw.a

To get the comprehensive list of operations checked by PolySpace, you can switch ¥ IDPg
to |mn mode. You may also want to use filters to focus on particular categories of X UNR.14
errors. Those filters are located at the top of the PolySpace Viewer window: AL

n PolySpace Viewer - C:\PolySpace_Results\RTE_px 02 New_Project LAST RESULTS.rte

File Edt ‘Windows Help « |[DP .28

= oo B f 4 wew Apa Ba S P

H F oo PROC NIV SCAL NIV FLOAT,
o - f x L osar || zov || MRS e || oor | pow || me || see | e [ RREET | aser | e | e | L || we | von

Note: When the mouse pointer moves on the filter, a tool tips gives its definition.
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B PontEr_AMTMELE ()
Filter ¥ DRE
» Click on | " | (top of the window) to suppress all DR
checks and click on | ™ . You will get list of checks
containing only IDP (lllegal Dereference Pointers) orzd
reds, or o B Pointer_Arithrmetic ()

¥ IDPA
» Click on ﬂ (top of the window) to suppress green code sections.

You will get a reduced list of checks reds, and grays:

3.3.5. Miscellaneous

The 9 icon gives access to the PolySpace Manual. All views have a pop-up menu (right click on mouse).

» Close the PolySpace Viewer window by clicking on the upper right [X] symbol
(PolySpace Viewer can also be closed using “File>Close”).

3.4. Methodological assistant

After this first usage of PolySpace Viewer, some simple questions remain:
* Do all checks need to be reviewed?
¢ |f not, what are the checks to review?
* How many?
* What is the best order?
The Methodological assistant answers to all theses questions. It helps to select and manage the checks
to be reviewed. It selects a “best” subset and sorts checks out.
The Assistant mode in the PolySpace Viewer will then guide you through these selected checks.

» If the PolySpace Viewer is still open, close it by clicking on the upper right ]| symbol, open it again,
load the same results and chose the “Assistant” mode.
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After having loaded the results in “Assistant” mode, PolySpace Viewer window looks like below:

B PolySpace Viewer - C:\PolySpace_Results\RTE_px_02_New_Project_LAST_RESULTS.rte (=]
Fle Edt Lok widows kep
OB o oo w B 1 s T P
[T | [, Osvemowe 4SS5 H D
o e o Gt o, Nohackcarerty sk
ochec sontea
o o bt o o) b e
ot

N A N 2 MK v o bl View Call Tree View

! = ! 0 1o Loy q \Variables
B example.c 1 o 100 [~ ) e project @
i\ polvspace: (sHERUgE: 8 0 N __polyspace_stdstubs errmo
@ _polyspace_main.c a] 0

y ITECHNDLOGIES
in partnership with ‘h
e cnes ¥
< >

Ll )
[ Jwatingora comman

3.4.1. Assistant dashboard

The second line of buttons on the toolbar and the two views just below are used to navigate between
the checks selected by PolySpace:

0 DOsiegmores 4 <& > » P

Codling r=view progress Count Pro..{ No check currently selected
Mo check selected i

i veviewerd i ta reviewr () e ia

Softuware relibilty indicator Inia|va
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PolySpace Viewer has also been updated as follows:

I. Now, in the "Procedural Entities" view the list of files analyzed is sorted out according to the methodological
assistant used.

2. In the source code view, each operation will be sorted out according to the PolySpace methodology

in the following order:

* Red: The methodological assistant browses all red errors.

» Gray: The methodological assistant browses unreachable code depending
on the radio button "Skip gray checks".

. The methodological assistant chooses and reviews the "best" unproven
operations - those that are the most probably actual errors.

§> B PolySpace Viewer - C:\PolySpace_Results\RTE_px_02_New_Project_LAST_RESULTS.rte
» Click on to go Fle Edt Took Widows Hep
OB v oo|ld E @ 1 & T e
to the next check. B Dsvesue € €S20 o ®
e S+ e =5 /% ou of bounds */
o 2y
Al
PolySpace Viewer has been 4
. Procecural eifes ¥ [Reviewea X[ 7] = =" =
refreshed with the first A S Call Tres
|35 New_Project o 7| 8 Variables e
check selected by the  [=== o 0 o [ ——
o PRERT I il 4 © cataaby ¢ < example RTE
1 H . - __polyspace_stdstubs ermo K
methodological assistant: o g freees e 1
o & Resd by taskc (3 -
e
o Uptteon selection
o e i . .
o =
+ IDP.31 =] s
Close_To_Zero () o 0 97 pHti
Non_infnte_Loop () o o d
RTE() o 0 100 if (get bus status() > 0)
Recursion_caller () o 0 101 {
Square_Root () o 0 102 if (get oil pressure() > 0)
° | F ‘
Unreachable_Code () 104 Ep = 5; /* out of bounds */
get_oll_pressure () o o 108 )
® _polyspace_ stdstubs.c o 0 106 else
. , :
__Polyspace_main.c [u] o e 3
)
w g
. alls :
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The methodological dashboard gives details and allows reviewing the check.

» Tick the review checkbox and type a comment in the text box on the right as follows:

| Methodology for C v 9270 [ skip graychecks 44 € @& & MW or1 P
Coding revievy progress Count Progress example.c / Pointer_Arithmetic ! line 104 f column 10
ik IDP reviewwed [ nk IDP to review (Red) 101 100
ko reviewed | nb to review (Red) m 25|| H Fp = 5; /* out of bounds */
Software reliability indicator 93115 &0
E I hawe reviewed this check and inserted a comment

Error : polinter is cutside its bounds

The left part of the dashboard has been updated, and displays some statistics in three lines:
* The first line gives the number and percentage of remaining checks to review in the selected category

(here, red IDP checks).
* The second line gives values for the whole colour category (red, grey and ).

* The last line gives values for the whole software being reviewed.
This is called Software reliability indicator. It gives the percentage of checks
compared to the total number of checks.

» or previous check that

Other buttons in the Methodological dashboard allow navigating to the next
hasn't been reviewed yet. It's also possible to refresh the different views to come back to the check currently

being reviewed using the % button.
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3.4.2. Choose a methodological assistant

Methodology for C w
Methodalogy for Ada

Methodalogy for C

Methodalogy for C++

 etho el Base o g —
Some methodologies KL Bad) sy and associated levels 2 a

have been pre-defined by PonSpace

The methodology allows selecting the categories of checks to review, the number for each category

and their order based on statistics on many analysis results.

The level defines the number of checks to review by category. It is chosen according to the development phase

during which the code has been analyzed: "Fresh code", "Unit test"and "Code review"

.I.t is possible to define your own Methodology in the BiPreferences PolySpace Viewer
Preferences >PolySpace Viewer>Assistant Toots Werw | Tae optos | Toabars optons | Miscllneous | Assistant confaureton
H H N is configuration menu allows the defirtion of Number of checks to review
methodology" tab that is accessible from the "Edit" menu. s e Croton1 Cerm2  Greon
It alows: o v
wifferert reviev criteria (used as tool tios of ST
the slider), e
Here, you can create a new configuration set and define | o e ateraiosseca serr
for each level what will be the categories of check to review [ oy s £8cmay
and how many of each category. s
IRy
Configuration st EHETY
Review threshald criterion %
el
Criterion 3 EE
o [ awy [ comcal |

33



3.5. Report Generation

When PolySpace performs an analysis, it generates textual files that can be used to create Excel® reports.
These files are located in the results directory (See "C:\PolySpace Results\PolySpace-Doc"

or "<PolySpaceInstallDir>\Examples\Demo C\PolySpace-Doc"). These files contain data related
to all views except the source code one.

Step 2: PolySpace Viewer - Exploration of results m@
!

The "C: \PolySpace Results\PolySpace-Doc" directory should contains the following files:

file Edi Yiew Favorites Tools  Help

(3 pack - ¥ | O search

nddress |2 PolySpace-Doc

Hame

[£] Mew_Praject Cal Tree

[Z] Mew_Project_RTE_view
Hew_Project_ariable_View
Hew_Project-HON-SCALAR-TABLE-AFPENDIX
| Pelyspace_macros

& C:\PolySpace_Results\PolySpace-Doc

Folders

Size
3KB
14 KB
1KB

195 KB

X ¥ E-

Type

Texk Document
Texk Document
Texk Document
PSFile

L5 File

5

v|Ed s
Date Modfied
5/9/2007 2:15 P
5/3/2007 2:15 P
5/9/2007 2:15 P
5/3]2007 2:13 P
5/3/2007 2:15 P

» Open the file called "PolySpace Macros.xls"
and enable macros to display the Excel® file:

A B C D E F G

Copyright © PolySpace Technologies, 1999-2006

Apply fikers? ————————— Generate checks by file?
& Mo filters ~ yes

" Beta filtars “no

Help | Use this button to create the complete synthesis in one file Help
Select the RTE export view and a file in which to save results
I the other views are in the same directory as the RTE view
then they will automatically be incorporated into the same file

Generate PolySpace Results Synthesis |

Reports can be generated from all PolySpace td file format results. These are generated
by the PolySpace Verifier during an analysis, the export option in the PolySpace Viewsr,
ar from the ling using the " Hiles" command

Individual PalySpace text result files can be processed using the helow macros

The macros are.

RTE Apply to RTE views exported from PolySpace Viewer
Call Tree Apply to Call Tree views exported frorn PolySpace Viewer
Variables Apply to Variable views exported fram PolySpace Viewer

Wersion 3.4.10 RTE = Run Time Error
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> Click on el e | A file browser opens. Select the file called
“New_Project RTE View.txt” as shown below:

Select a RTE View text file

Regarder dans : ‘,‘j PolySpace-Doc ﬂ @ > - Outils ~

Mew_Project_Call_Tree.txt
3]

Historique

E New_F'rDjectVa

A

Mes documents

s Nom de fichier : | | Quwrir

[=]
Favaris réseau Type de fichiers |Text Files (*.bxt) ﬂ annuler

After a few seconds, an Excel® file is generated.
It contains several spreadsheets related to the application analyzed.

" Application Call Tree /| Shared Giobak [ Global Data Dicbanary /. Chacks by e/ Chock Synthess ( Laundhng Options / RTE > M checks beaton / Orange O
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For example, in “Checks Synthesis” all statistics about checks
and colors are reported in a summary table.

A | B [c|p|E|F| 6

1 RTE Statistics

2 | Check category Check detail RO Gy Gr % proved
_ 3 |OBAI Out of Bounds Array Index 0jojo o 0,00%
_4 |NIVL Uninitialized Local Variable 0 1128 100,00%
_ 5 |IDP llegal Dereference of Pointer |1 0 |7 | 88,89%
_6 [NIP Uninitialized Pointer 000 12 100,00%
T [NV Uninitialized Variable 000 '8 | 100,00%
_8 |IRV Initialized Value Retumed 000 (15 100,00%
_ 8 |COR Other Correctness Conditions |0 0 |0 |2 | 100,00%
10 |ASRT User Assertion Failure 0jojo o 0,00%
11 |POW Power Must Be Positive 0jojo o 0,00%
12 |7Dv Division by Zero 0170 4 | 80,00%
13 |SHF Shift Amount Within Bounds |0 0 (0 |0 0,00%
14 |OVFL Overflow 032 |8 | 76,92%
15 |[UNFL Underflow 012 19 | 9167%
16 |UOVFL Underflow or Overflow 030 |4 | 57,14%
7 |[EXCP Arithmetic Exceptions 0jojo o 0,00%
18 |NTC Mon Termination of Call 3000 [0 | 100,00%
19 [k-NTC Known Mon Termination of Call |0 0 |0 |0 0,00%
20 |NTL Mon Termination of Loop 0jojo o 0,00%
_21 |UNR Unreachable Code 0jojo o 0,00%
22 |UNP Uncalled Procedure 0jojo o 0,00%
23 |IPT Inspection Point 0jojo o 0,00%
24 |OTH other checks o000 |o 0,00%
25 |Total - 41915 97| 9217%
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Step 3:
Setting up and launching the MISRA-C checker

This paragraph describes how to perform the MISRA-C compliance verification in the analysis of "example.c".
This verification takes place during the ANSI C compliance phase of the analysis.

4.1. Prerequisites

If PolySpace Client is already opened with the project defined previously (see Step | of this Getting Started)
you can skip the following two steps.

ZKB

» If PolySpace Client has been closed, please open it again g e
by double-clicking on the PolySpace Client icon: 7L

B PolySpace Client
» Select the saved project: [N Edit Tools Help
J Mew project
) Dpen project

1

] ce_Resulksidemo.dsk
!

: &
Quit [Parses the project Ctr+Q

The project needs to be updated as follow:

» The "Check MISRA rules" option needs to be activated. To do so, type "misra"
in the "Search internal name from the selected line" box searchniema name fromthe selected line: | misrs =h
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» Then click on . It will show all options containing the word "misra".
Tick the "Check MISRA-C: 2004 rules" option and expand it to see the two associated sub-options
-misra2 and -includes-to-ignore :

bt thaewenn polyspace cormtni

Rules configuration

E]-misra2

Filez and directories to ighore

.. Hncludes-to-ighare

» Make sure “example.c”
is selected:

» Modify the results directory:

The PolySpace Launcher
should now look like that:

We will detail theses
two sub-options later.

Results Directory [-results-dir]

C\PolySpace_Misra_Results

demo.dsk E ‘

File Marme Abzalute Path

S e D ]

Vo

icrol e

[ e drectories [

5 cpayseacens Terarpiesters Csoscss

Results Directory [-zesuia-ase]

s Rosts i

T i e I I

i [ »

Bf conpioion
B
Fram
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4.2. Configuring PolySpace MISRA Checker

4.2.1. Selecting rules to verify
» Click on L) next to "-misra2".

=

hittg: finenewe polyspace cominisra-checker him

Rules caonfiguration

Files and directories to ignore

[:] misra?

. |-inchudesto-ignare

This opens a new window as below:
[] L]

e
Dom

tesse boad o crete o i s confiuration

» Click on []. It creates a new MISRA-C configuration file.
The content of the window is updated as below:

B New File X
File
0o\

Setthe following state to al MISRA rules: Error v
Rules Errar Wamning  Off Comments
MISRA C rules

2 Language extensions
D

4 Character sets

# £ iertifiers

® BTypes

7 Constants

& Declarations and defintions

9 itiaisation

Each rule can be set as follows:

* “Error”: this MISRA-C rule must be respected.
If one or several deviations are detected, the ana-
lysis will stop at the end of the compilation phase.

* “Warning” if this MISRA-C rule is not
respected, a warning will be displayed,
but the analysis will continue.

» “Of£”: the MISRA-C rule will not be verified
by PolySpace MISRA Checker.

10 Arfihmetic type conversions

11 Painter

# 12 Exressions.

# 13 Cortral statemert expressians

14 Cortral flow

15 Switch statemerts

16 Functions

17 Painter and arrays

18 Structures and unions

19 drectives

# 20 Standard liraries

21 Run-time failures.
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Set the following stete to all MSRA rues : Errar v

%‘“’

YWarning | Off Comments

The default setting for all rules is “Warning”. I } I

» For the MISRA-C compliance verification of the "example.c" file, please update the setting to "Of£"
for all rules and apply it using the button

» Then, click on H to expand the set of rules 2 and 16. - "Languages extensions" and "Functions".
The status of some of the underlying rules cannot be modified (rules 2.4, 16.7 and 16.10). Other rules have
been turned to "Off". Click on the "Warning" column for rule 2.2 and on the "Error" column for rule 16.3.
The green dot moves from column "O££" to column "Warning" and "Error"-. This means that PolySpace

HISRA Chscker vl Verlfy whether
gl New File
= the rule 2.2 and 16.3 are respected
Fle .
0oa and will stop after the ANSI
Setthe following state to all MISRA ries: (017 v Compl'ance checki ng phase
Fies Eror | Warg | off e if rule 16.3 is not respected,
) &
= 2 Language extensions 5
21 Mssemaly language shal be and isolated ) ®
2.2 source code shal orly use .. #/ style comments (@] [
2.3 The character sequence # shallnot be used witin 3 commert O
2 4 Sections of code should not be 'commented out'
30
4 Character sets
& dertifiers
5 Types
7 Constants
8 Declarations and defintions
15 Switch stetemerts
16 Functians
181 Functions shall not be defined with variable numbers of arguments. ) O
16.2 Functions shall not call themsehves ether directly or increcth )
ofa [9] E § ®)
16.5 Functions with n parameters shallbe declared with parameter type void O
1B.6 The number of argumerts passed to a function shall match the number of par|
16.7 A pointer parameter in & function prototype should be declared as poirter 1o
16.5 Al g5t paths Trom & function with non-void return type shal have an explict ®
168 A function idertiier shall orly be used wih efher & preceding &, or wihapsl () [@]
16.10 H 2 function returms error information, then that errar infarmtion shaud be ¢ _
17 Painter and arrays
18 Structures ahd unions
T 10 Dranvnnassing Aivastivas bl
< I >
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» Click on H to expand the set of rules 17 - “Pointers and arrays” - and select “Warning” for rule 17.4.
This means that PolySpace MISRA Checker will verify whether the rule 17.4 is respected and display
a warning message if this is not the case - but not stop the analysis.

File
ODowW
Setthe folowing stete to sl MSRA rules . ©1f v
Rules Erer  Waming | Off Commerts
MISRA.C rules
Number of rules by more : 5 3 133

1 Environment.
2 Language extensions

3D _
4 Character sets !j

5 Idertifiers

8 Types

7 Constarts

& Declarations and defintions

a Infilisetion

10 Arithmetic type

11 Pointer type

12 Exressions

13 Contral statemert

14 Control flow

15 Swich statemerts

16 Functions:

1= 17 Poirter and arrays

17.1 Poirter arithmetic shall only be applied to pointers that acdsiress an array or an
17.2 Poirter subtraction shal only be applied to poirters that ackdress elemerts of
17.3 2, ==, =, == shall not be applied to pointer types except where they poirt to th
17.4 Arvay indexing shal be the only slowed form of poirter erthmetic (@)
17.5 The declaration of ohjscts should contsin no more than 2 levels of pointer indi
175 The aderess of an object with automatic storage shell not be assinedtoane ()
16 Structures and unions
13 ing directives
20 Standard ibraries

21 Runi-time failures

N

£

| >

> Clickon L_%_J. A “save as ...” window opens, enabling to save the current configuration.
Name it "misrarules.txt" and save it in the "C: \MISRA results" directory.
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4.2.2. Discard header files from MISRA Checking

You can disable MISRA verification on predefined files. For example, you may want to disable
the MISRA-C verification of “math.h”, included in “example.c”.

» To do so, click on L) next to the ~includes-to-ignore option. The “Files and directories to ignore”
window opens, enabling to disable the verification of MISRA-C rules on selected files and directories.

Files and directaries ta ignare [Hncludes-ta-ignare]
(+)(- =] » Select “math.h” using the browse button and click on

EeRiEilg to close the window. This file will not be checked.

(2]

[ Ok ] [ Cancel ]
4.3. Running the MISRA Checker ..Pnl.y‘Space Desktop for C - C:\WPolySp
N Edi Tools Hel
B . R o ~ R _'] Haw project
» Before starting this analysis of “example.c” with MISRA-C checker, &= Onen project
select “File>Save as new project” and choose another name I save project
for the current PolySpace project. W
1) C:\PokySpace_Redttlts\dema.dsk
b ooui Crlhg

»Click on to start the analysis.
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During the new analysis a new filter button is displayed - B msra Log - in the log view.
This button allows filtering out messages associated to MISRA-C compliance verification.
>
I e R I T T

B convle Lo

B v oo

B

[+ Furtos

Message
At the end of the compilation process, PolySpace Client shows
the following error message: @ fetikatoyprocess ok

» Click on .

The analysis has been interrupted, because the MISRA-C Checker found that rule 16.3, marked as “Exrror”,
has not been respected. A list of MISRA-C errors and warning messages appears in the bottom window.

q Verifying C files
If we focus on the MISRA log using | verifying example.c
the appropriate filter | Ef msraog , | Verifying sources ...

| ared Verifying example.c
°n)’ messages associate ../sources/include.h:34 : MISRA-C ERROR : rule 16.3 (required) violated.
to MISRA-C are disp|ayed. | Identifiers shall be given for all of the parameters in a function
The "Search in log" box allows prototype declaration.

g example.c:97 : MISRA-C WARNING : rule 17.4 (required) violated.
searching for' a speciﬁc keywor‘d | Array indexing shall be the only allowed form of pointer arithmetic.
example.c:113 : MISRA-C WARNING : rule 17.4 (required) violated.

Sl.JCh as the rei"'erence numb“er Of"a | Array indexing shall be the only allowed form of pointer arithmetic.
given rule. Let's search for "16.3". example.c:117 : MISRA-C WARNING : rule 17.4 (required) violated.
| Array indexing shall be the only allowed form of pointer arithmetic.
example.c:121 : MISRA-C WARNING : rule 17.4 (required) violated.
| Array indexing shall be the only allowed form of pointer arithmetic.

43



e
Step 3: Setting up and launching the MISRA-C checker m@
!

» Here, the recommendation is clear — an identifier is missing in a function prototype and must be added in
“include.h” as required by MISRA-C rule 16.3. Once this is done, you can re-launch the analysis.

Note:

You can also change the setting of rule 16.3 from “Error” to “Warning”, and launch the analysis again.
The error message will change to “MISRA-C WARNING”, and the analysis will not stop after the ANSI
checking phase.

When no error remains after the ANSI checking phase, the analysis continues as described in step I, and will
give results as described in step 2.

Note:
A log file, located at the root of the “C:\PolySpace Misra Results” directory with “.1log” as a suffix,
contains all messages displayed in the bottom window, including MISRA-C messages. The format of the log file
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Launch PolySpace Remotely

This paragraph describes the basic steps to launch an analysis in remote. To do so you need:
I. A Queue Manager server (QM) installed.
2. Your desktop PC configured with a PolySpace Client.
3. A networked machine configured with a PolySpace Server.

Please see the PolySpace Installation guide (available on the PolySpace CD-ROM in \Docs\Install)
to install and configure, the Queue Manager, a Client and a Server.

Note: Launching an analysis remotely requires a PolySpace Server product and associated license.

5.1. Launching an analysis

It can be done in two steps:
» Step |: set up an analysis as described in Chapter 2 but do not launch it.

» Step 2: tick the “Remote analysis” checkbox (see figure below) and click on
to launch the analysis.

iv) o

Complle - 0% ]lmermemata-n%] COFA 0% l Levell 0% ] Level2: 0% ] Leveld D% l Leveld: 0% ]TEM

00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 000000 000000
Compile Log Search inthe log : @
1 stats
[# FulLog

52t parametar ...
ey
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The analysis starts and the compilation phase is performed on the desktop PC. At the end of the “C source
verification phase” the analysis is sent to the Queue Manager server. By clicking on the “Full Log” tab, you will
see a message like this:

ke s 7] °

[ reomoameion | cormion [ Lewniow | tovelion | teenios | Lewrion | rom
o Ending ac: Har 17, 2005 175852 3
[ Fillag  Tser time for ouif: 16.7real, 9.2u + 63 [0ge]

Generating remote file
User time for polyspace-ci l8.dreal, 10.1u + 6.8s {0gc)

** End of PolySpace Verifier analysis

lAdding the analysis to the queue ...
£ the axchive to th

lnalysis 0 : 4
The analysis has been queusd. You may follow its progress using the spooler.

The analysis has been queued with an ID number, and you can follow its progression using the PolySpace Spooler.
If you do not tick the “Remote analysis” checkbox, the analysis continues locally.

5.2. Management of PolySpace analysis in remote:
the PolySpace Spooler

You can check the analysis processes in the queue by clicking on the short cut on your desktop PC
in the menu tab of the launcher.

?_.‘_g PolySpace Spooler 3.3 or on the icon
> o

0 B PolySpace Spooler

Operations  Help

1D _[Author [Application|Resutts directory [cPu [Status [Date

1| PolySpace | Demo_G | ciDema_C_results | testar | completed | 13-Mar200610:3726 | C |

FolySpace C\RESULT Shresults_voa completed
bard

FolySpace

46



When you select an analysis and right click, you can manage it in the queue:

- PolySpace Spooler

Operations Help

ID | Author Application| Results directory Folow progrss ... tatus Date Language
1 FolySpace Dermo_C chDerr View log file completed 13-ar-2006, 10:37:26 C
2 FolySpace CARESLIL IR completed 13-hdar-2006, 12:1%:41 E,
c completed 15-h 12:40 C
4 FolySpace Demo_C c\RESUL completed 17-Mar-2006. 18:03:44 C

Move down in queue

Kil and download results ...
Kil and remave from queue ...

Remove from queue ...

"Follow progress" displays the associated log file in a Launcher window. If the analysis is running,

you can follow the update of the log file and associated progress bar in real time.

"View log file" displays the associated log file in a "Command prompt" window, in which you can see

the last 100 updated lines of the log file in real time. This option is only available when the analysis is running.
"Download results" downloads the results of an analysis to the Client. If the analysis is still running,

already available partial results are downloaded on the Client, without disturbing the analysis.

This option is not available for a "queued" analysis (that has not yet began).

"Move down in queue" reduces the priority of a "queued" analysis.

"Kill and download results" stops the analysis definitively and the latest available partial results are downloaded.
The status of the analysis changes from "running" to "aborted". The analysis remains in the queue.

"Kill and remove from queue" stops the analysis definitively and removes it from the queue.

The results will be lost.

* "Remove from queue" removes a "queued”, "aborted" or "completed" analysis. The results will be lost.
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The queue can also be managed via the "Operations>" menu:

Purge queue [|

Flease selectthe action you want to perform and type the administrator password

Action |Purge completed and aborted analysis ﬂ

Furge the entire queue

Fassword :

* "Operations>Purge queue" purges the entire queue or purges only completed and aborted analysis
(see below). The queue manager administrator password is required.

* "Operations>Change root password" changes administrator password of the queue manager.
By default, the password is "administrator".

5.3. Batch commands

* Launch analysis in batch:
A set of commands allow the launching of analyses in batch (under a Cygwin shell on a Windows machine). All
commands begin with the prefix <PolySpaceCommonDir>/RemoteLauncher/bin/polyspace-remote-.
Commands available are polyspace-remote-c and polyspace-remote-desktop-c.

They are equivalent to the commands with a prefix <PolySpaceInstallDir>/bin/polyspace-.

For example, polyspace-remote-desktop-c -server [<hostnames: [<port>] | auto]
allows the sending of a C Client analysis remotely.
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* Manage analysis in batch:
In batch and on a UNIX platform, a set of commands allow the management of analysis in the queue.
All theses commands begin with the prefix <PolySpaceCommonDir>/RemoteLauncher/bin/psqueue-:

* psqueue-download <ID> <results dirs>: downloads an identified analysis into a results directory.
[-£] forces download (without interactivity) and -admin -p <passwords allows administrator
to download results. Use [-server <name>|[:port]] to select a specific Queue Manager.
Use [-v|version] to indicate release number.

* psqueue-kill <IDs>: kills an identified analysis.

* psqueue-purge all]|ended: removes all or finished analyses in the queue.

* psqueue-dump: gives the list of all analyses in the queue associated to the default Queue Manager.

* psqueue-move-down <ID>: moves down an identified analysis in the queue.

* psqueue-remove <ids>:removes an identified analysis in the queue.

* psqueue-get-gm-server: gives the name of the default Queue Manager.

* psqueue-progress <ID>: gives progression of the currently identified and running analysis. PR
[-open-launcher] displays the log in PolySpace launcher graphical user interface. [-full] § :
gives full log file.

* psqueue-set-password <old password> <new passwords: changes administrator password.

* psqueue-check-config: checks the configuration of Queue Manager. [-check-licenses]
checks for licenses only.

* psqueue-upgrade: allows upgrading a Client (see PolySpace Install Guide
in the <PolySpaceCommonDir>/Docs directory). [-1ist-versions] gives the list of available
releases for upgrade.
[-install-version <version number> [-install-dir <directorys>]] [-silent]
allow to install an upgrade in a given directory potentially in silent mode.

Note: <PolySpaceCommonDir>/RemoteLauncher/bin/psqueue-<command> -h gives information
about all available options for each command.
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5.4. Share analysis between accounts

* analysis-key.txt file
For security reasons, all analyses spooled are owned by the user who sent them. Each analysis has a unique crypted key.

The public part of the key is stored in a file named analysis-keys. txt and associated to a user account.
On a UNIX account, this file is located in: "/home/<username>/ . PolySpace".On a Windows account,
it is located in: "C: \Documents and Settings\<username>\Application Data\PolySpace".

The format of the ASCII file is the following (*t means tabulation):
<ID of launching> “t <server name of IP address> "t <public key>

Example

1 ml20 27CB36A9D656F0C3F84F959304ACF81BF229827C58BE1A15C8123786
2 ml20 2860F820320CDD8317C51E4455E3D1A48DCES76 F5C66BEEF391A9962
8 ml20 2D51FF34D7B319121D221272585C7E79501FBCC8973CF287F6C12FCA

When attempting to manage (download, kill and remove, etc.) a particular analysis, the Queue Manager will examine
this file and check the associated public key before allowing the action.
If the key does not exist, an error message appears: "key for analysis <ID> not found".

So, if user A wants to manage (for example download results of) an analysis sent by user B, user A should edit his own
analysis-key.txt file and add into it the line corresponding to that analysis in the analysis-key.txt file of user B.

* Sharing analyses between projects with a magic key
A magic key allows sharing analyses without taking into account the <ID>. It allows having the same key for all analyses
launched. The format is the following: 0 <Server id> <your hexadecimal value>

All analyses spooled will use this key instead of a random one. This would allow any user that has this key
in his analysis-key.txt file to manage all analyses sent with the magic key.

Note: The magic key only works for analyses launched after it has been set up.
Analyses sent before, will keep their auto-generated random keys.
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Conclusion

After having followed each steps of this tutorial, you are now able to launch an analysis using PolySpace Client,
enabling or not the MISRA verification phase and review some results with PolySpace Viewer.

All theses activities can be performed locally on your desktop PC or in a Client/Server architecture.

You will find more information on advanced options in "PolySpace C documentation.pdf" which is available
on the PolySpace CD-ROM or by clicking on @ in PolySpace tools.
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